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Introduction
Inflation Adjustment allows you to adjust your General Ledger account balances for 
each period of the fiscal year according to the rates published by the government. 
These adjustments will accurately reflect the change in the value of an account due 
to inflation on a given date. You can set up indices and/or coefficients of inflation to 
calculate inflation adjustment. You can also use other methods of adjusting 
inflation, such as Monetary, External Calculation, Manual Entry, With Monetary 
Revaluation and REPPAM. You can also generate reports for all the accounts that 
have been adjusted.

You must have installed the Collection and Payment Methods - Withholds and Tax 
Listing modules before you can use Inflation Adjustment. 

Check for current instructions
This information was current as of February 2007. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
online Web site (http://go.microsoft.com/fwlink/?LinkID=79222) for the most 
current documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Inflation Adjustment, and how it integrates with the Microsoft 
Dynamics™ GP system.

To make best use of Inflation Adjustment, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Setup,” describes how to set up Inflation Adjustment so that it 
meets the needs of your business and integrates with the other modules you 
use. 

• Chapter 2, “Routines,” describes the various activities that you must perform in 
order to adjust inflation for a specified period for a specific account, or a range 
of accounts.

http://go.microsoft.com/fwlink/?LinkID=79222
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• Chapter 3, “Reports,” describes the process of printing setup reports for 
inflation adjustment.

Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites 
tab. Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently 
displayed, type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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appropriate link in the topic. You also can press F1 to display Help about the 
current window.

Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

Orientation Training
Accesses online tutorials that show you how to complete basic procedures within 
Microsoft Dynamics GP. Additional tutorials are available through the 
CustomerSource Web site.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.
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CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

U.S. Payroll Updates
Provides access to tax updates for state and federal tax withholding. When you 
select an option, the process to install the updates will begin immediately.

Check with your system administrator before installing tax updates. To be sure that tax 
updates are installed correctly, refer to documentation for specific tax updates on the 
CustomerSource Web site.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.

Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
Inflation Adjustment allows you to set up an index and/or coefficient of inflation 
for each period of the fiscal year according to the rates published by the 
government. You can also use other methods of adjusting inflation, such as 
Monetary, External Calculation, Manual Entry, With Monetary Revaluation and 
REPPAM. You can set up inflation adjustment for a group, and further assign a 
range of accounts to a group ID. You also can set up inflation adjustment per 
account.

When you set up Inflation Adjustment, you can open each setup window and enter 
information, or you can use the Setup Checklist window (Microsoft Dynamics GP 
menu >> Tools >> Setup >> Setup Checklist) to guide you through the setup 
process. See your System Setup Guide (Help >> Contents >> select Setting up the 
System) for more information about the Setup Checklist window.

This information is divided into the following sections:

• Setting up the index ID/coefficient ID
• Setting up adjustment groups
• Assigning a group ID to a range of accounts
• Setting up inflation adjustment
• Setting up inflation adjustment per account

Setting up the index ID/coefficient ID

Use the Adjustment Index-Coefficient Configuration window to set up the index ID 
or coefficient ID to calculate inflation adjustment.

To set up the index ID/coefficient ID:
1. Open the Adjustment Index-Coefficient Configuration window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Financial >> Inflation 
Adjustment >> Indices/Coeficientes)

2. Enter an index ID or a coefficient ID. 

3. Enter a description for the index or coefficient ID in the Description field.
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4. Select the year for which you are setting up the index/coefficient ID.

5. In the Date From column, enter a beginning date for each period of the selected 
year. The beginning date for the first period must be 00/00/00 to calculate the 
inflation adjustment correctly.

6. In the To Date column, enter an ending date for each period of the selected year.

The dates you enter here must cover the entire selected year. However, the number of 
periods that you set up in a year will depend on the number of times the inflation rates 
are revised by the government. 

7. Enter the inflation percentage in the Period Coefficient/Index column for each 
period to calculate the inflation adjustment.

8. Choose Save to save the index/coefficient ID you’ve set up.

9. Choose Clear to clear the values displayed in the window.

10. Choose Delete to delete the displayed index/coefficient ID.

Setting up adjustment groups

You can set up a group ID to calculate the inflation adjustment for a group.

To set up adjustment groups:
1. Open the Adjustment Group Configuration window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Financial >> Inflation 
Adjustment >> Conf. Groups) 

2. Enter a Group ID. You can enter upto 10 alphanumeric characters in this field.

3. Enter a description for the group ID in the Description field.

4. Select the inflation adjustment type to be used for the group ID.

Monetary  Select this option to adjust the inflation using currency.

External Calculation  Select this option to adjust the inflation using 
external calculations.

Index/Coefficient  Select this option to adjust the inflation using the index 
or the coefficient IDs.
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Manual Entry  Select this option to adjust the inflation by manual 
calculations.

With Monetary Revaluation  Select this option to adjust the inflation by 
revaluing the currencies.

REPPAM Select this option to adjust inflation using REPPAM.

5. Enter or select an Index or Coefficient ID if you selected index/coefficient as the 
adjustment type. This will be the default index/coefficient ID for the group you 
are setting up.

6. Select the account to be used as an adjustment account for all the accounts 
associated with the group ID. This field is available only if the adjustment 
method is Index/Coefficient or External Calculation.

Same Account Select this option to post each adjustment to the account that 
is being adjusted.

Other Account  Select this option to post the adjustment for all the 
associated accounts to a specific account entered in the Account No. field.

The selected account is used along with the global adjustment account while 
calculating inflation. Refer to Setting up inflation adjustment on page 8 for more 
information on global adjustment account.

7. Enter or select an account in the Results Contra Account field to be used as a 
compensation for the adjusted account. This field is unavailable for Manual 
Entry, With Monetary Revaluation and REPPAM type of adjustments.

8. Enter or select an account in the Acct. Results by Holdings field to be used as a 
holding account.

9. Choose Save to save the values you have entered.

If the group is associated with an account or a range of accounts specifically or by means 
of a main segment, you can choose to transfer the setup for the group ID to the 
associated account range.

10. Choose Clear to clear the values displayed in the window.

11. Choose Delete to delete the selected group ID.

Assigning a group ID to a range of accounts

Use the Adjustment Configuration by Principal Segment window to assign a group 
ID to accounts based on their principal account segment. The group ID settings are 
used to adjust inflation for all accounts having the selected principal segment. You 
can also copy the settings from one segment to a range of segments.
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To assign a group ID to a range of accounts:
1. Open the Adjustment Configuration by Principal Segment window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Financial >> Inflation 
Adjustment >> Conf. x Seg. Principal)

2. Select a principal segment.

3. The Description field displays the description for the selected segment.

4. Enter or select a Group ID in the Adjustment Group ID field. All the accounts 
having the selected segment will use the settings of this group ID for inflation 
adjustment. 

5. Choose Copy to copy the settings to a range of segments.

6. Enter or select a beginning segment number for the range in the From Segment 
field. The Description field displays the description for the beginning segment 
number.

7. Enter or select an ending segment number for the range in the To Segment field. 
The Description field displays the description for the ending segment number.

8. Choose Save to save the values you have entered.

9. Choose Clear to clear the values displayed in the window.

10. Choose Delete to delete the selected principal segment.

Setting up inflation adjustment

Use the Adjustment Configuration window to define whether inflation is calculated 
as an index or as a coefficient.You can assign a source document code, a batch ID 
and an adjustment account for each index or coefficient ID that you have set up.
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To set up inflation adjustment:
1. Open the Adjustment Configuration window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Financial >> Inflation 
Adjustment >> Config. General)

2. In the Enter Variations such as field, select whether to calculate the inflation 
adjustment based on the indices or on the coefficients specified in the 
Adjustment Index-Coefficient Configuration window.

3. Enter or select an Index or Coefficient ID.

4. Enter or select a Source Document ID in the ID Source Doc. for AXI entry field 
to identify the journal entry created while adjusting inflation.

5. Enter or select a Source Document ID in the Doc. Source Rev. AXI Close to 
identify the reversal journal entry for the distribution created while adjusting 
inflation.

6. Enter or select a global adjustment account for inflation adjustment. This 
account is used with the account specified - Same or Other Account, in the 
Adjustment Group Configuration window. Refer to Setting up adjustment groups 
on page 6 for more information.

7. Enter a batch ID to identify the batch created in the General Ledger for the 
inflation adjustment entry. This batch will have all the records that are to be 
posted to reverse the journal entries at the end of a fiscal year.

8. Select the type of revaluation in the Type of Input field.

9. The Doc ID and the Description columns in the scrolling window lists the 
source documents IDs and the descriptions respectively of the journal entries 
for the adjustments.

10. Choose Save to save the selections you have made.

11. Choose Clear to clear the values displayed in the window.
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Setting up inflation adjustment per account 

Use the Accounts/Adjustment Maintenance window to specify the default inflation 
adjustment settings for each account you have set up in Microsoft Dynamics GP.

If you specify the settings for an account, and then assign it to a group ID, the inflation 
adjustment settings for the group will override any settings you earlier specified.

To set up inflation adjustment per account:
1. Open the Accounts/Adjustment Maintenance window.

(Cards >> Financial >> Account >> Enter or select an account >> Additional >> 
Maintenance of Account/Adjustment)

2. The Account and the Description fields display the account selected in the 
Account Maintenance window.

3. Select the base to be used to adjust the account.

Principal Segment Select this option to adjust the account based on its 
principal segment.

Group ID Select this option to adjust the account based on the Group ID it 
belongs to.

Specific  Select this option to choose a specific type of adjustment for the 
account.

4. Enter or select an Adjustment Group ID if you have selected Group ID as the 
adjustment base.

5. Enter or select the Adjustment Type if you've selected Specific as the 
adjustment base.

Monetary  Select this option to adjust the inflation using currency.

External Calculation  Select this option to adjust the inflation using 
external calculations.

Index/Coefficient  Select this option to adjust the inflation using the index 
or the coefficient IDs.
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Manual Entry  Select this option to adjust the inflation by manual 
calculations.

With Monetary Revaluation  Select this option to adjust the inflation by 
revaluing the currencies.

REPPAM Select this option to adjust inflation using REPPAM.

6. Enter or select the index ID or the coefficient ID if you've chosen index/
coefficient as the adjustment type.

7. Select an account to be used as an adjustment account. These fields are available 
only if the adjustment method is Index/Coefficient or External Calculation.

Same Account  Select this option to post each adjustment to the account 
that is being adjusted.

Other Account  Select this option to post the adjustment for all the 
associated accounts to a specific account entered in the Account Adjustment 
field.

8. Select an account in the R.E.I Account field. This account will be used as the 
global adjustment account if you have selected REI + RxT type of input in the 
Adjustment Configuration window. Refer Setting up inflation adjustment on 
page 8 for more information.

9. Select an account in the Acct. Results by Holdings for adjustment. This account 
will be credited with the difference amount if you have selected the type of 
input as REI Gen. Segregating RxT or REI x Origin Segregating RxT.Refer to 
Setting up inflation adjustment on page 8 for more information.

10. Choose OK to save the values you’ve entered.

11. Choose Cancel to close the window without saving changes.
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Chapter 2: Routines
Use this information to run the process of adjusting inflation for a specified period 
by selecting the adjustment and reversal dates. The account balances are adjusted 
for any transactions in the selected period.

This information is divided into the following sections:

• Adjusting inflation for a period
• Adjusting inflation for external calculations

Adjusting inflation for a period

Use this information to process the inflation adjustment for a specified period.

To adjust inflation for a period:
1. Open the Adjustment Process window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Financial >> 
Adjustment Process)

2. Select a period in the Adjust to Period field for which to calculate the inflation 
adjustment.

3. The Tax Year field defaults based on the period selected.

4. The Date Adjustment field displays the ending date of the selected period.

5. The Date Reversion field displays the date on which the adjustment will be 
reversed. This date is always a day after the adjustment date.

6. Enter or select an Index/Coefficient ID. 

7. Mark the Include Non-Posted Records check box to include unposted 
transactions from the General Ledger in the report.

8. Select whether to perform the adjustment or print a preview report before 
adjusting.

Record Select to perform the adjustment.

Report Select to view a report before performing the adjustment.

9. Enter the range of accounts for which to print the adjustment report in the From 
Account and To Account fields respectively. These fields are available only if 
you have selected the Report option.
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10. Choose Accts. External Calculation to open the External Calculation Accounts 
window where you can adjust the balances for the accounts defined in the 
External Calculation type of adjustment. Refer Adjusting inflation for external 
calculations on page 14 for more information.

11. Choose Process to process the inflation adjustment if you've selected record, or 
to preview the report if you've selected report.

12. Choose Clear to clear the values displayed in the window.

Adjusting inflation for external calculations

Use this information to manually adjust the balances of the accounts defined in the 
External Calculation type of adjustment. 

To adjust inflation for external calculations:
1. Open the External Calculation Accounts window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Financial >> 
Adjustment Process >> Accts. External Calculation)

2. The Account Number column displays all the accounts defined in the External 
Calculation type of adjustment.

3. Enter the adjustment amount for the accounts whose balances have to be 
adjusted in the Adjusted Balance column.

4. Choose OK to save the adjustment amounts you’ve entered and return to the 
Adjustment Process window.

5. Choose Process in the Adjustment Process window to process the adjustment 
amounts you’ve entered.

6. Choose Cancel to cancel the process and close the window.
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Chapter 3: Reports
You can use this information to print reports for the inflation adjustments you have 
set up.

Inflation Adjustment reports are available in the report list. You can select a report 
in the report list and add it to My Reports for easy access. Refer to the Microsoft 
Dynamics GP documentation for more information.

This information is discussed in the following section:

• Printing setup reports

Printing setup reports

Use this information to print the various types of reports you’ve set up.

To print setup reports:
1. Open the AXI Configuration Reports window.

(Reports >> Financial >> AXI Configuration Reports)

2. Select a report option.

Configuration of Index/Adjustment Coefficient Select this option to 
print an Index/Coefficient Configuration report.

Enter an index/coefficient ID range and the year range for the report. The 
report will list all the index/coefficient IDs set up for the year range, along with 
the index/coefficient for each period of each year.

General Adjustment Configuration Select this option to print the 
general inflation adjustment configuration you’ve set up.

Configuration of Adjustment Groups Select this option to print the 
details of the adjustment groups you’ve set up. Enter a group ID range to print 
the report in the From Group ID and Up to Group ID fields.

Adjustment Configuration by Segment Select this option to print the 
adjustment details you’ve set up based on the segment. Enter a segment range 
to print the report in the Segment From and To Segment fields.
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Adjustment Configuration by Account Select this option to print the 
adjustment details per account. Enter a range of accounts in the From Account 
and To Account fields.

3. Choose Print to print the selected report.
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